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A Few Words from our President, Clive Dyson: 
Hi Folks, 

Early May saw the 2021 Annual SeniorNet Federation AGM and Symposium 
occur in Dunedin this year.  Both Kay and I attended along with around 80 oth-
ers from Learning Centres all over NZ – from the Far North (Bream Bay, up by 
Marsden Point) to the Deep South.  
 
The AGM itself was brief, over and done within a short period of time but the 
main event was the “meetings of minds” over the two days.    There were 
“table-talks” set up, covering a variety of subjects and facilitating exchanges of 
ideas and experiences including the common theme of declining membership 
attendance at courses and lack of willing volunteers.   
 
We heard guest speakers from sponsors of several organisations important to 
SeniorNet - AMI insurance, Westpac Bank (Head of their Fraud Team who 
spoke enlighteningly about the types of scams taking place), Google spoke 
about one of the few occasions that Google and Apple had combined to assist 
in developing the Covid 19 app currently in use in NZ. Suzuki Motors (featuring 
speaker Emma Gilmore, Rally Driver) had several cars on site for review by 
attendees.  As well, we heard presentations on digital inclusion and artificial 
intelligence and their effects on all our lives.  
Lastly we had words from Hon Dr Ayesha Verrall  MP, the Minister for Seniors. 
She praised SeniorNet for its help in the community, thanked Dr Vinay Kara-
nam for his development work on the new SeniorNet Hangouts online learning 
application (opening shortly – more news of this to come). 
 
For us here in Motueka, our new Top of the South Representative will be the 
very enthusiastic Roger Pittman of the Nelson SeniorNet Learning Centre.  He’ll 
become better known to you as he’s kindly agreed to deliver some more ses-
sions for us – starting with one taking place June 25th.    Roger is pictured below 
(far left) along with Sally Douglas from the Golden Bay Learning Centre, Rod 
Lewis from Nelson, Kay and me. 
 
Cheers, Clive 

May 2021 

http://www.westpac.co.nz/who-we-are/seniornet/
https://newzealand.googleblog.com/2020/05/enabling-digital-transformation-of.html
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June (and late May) Dates for your Diary 
(see our website for more details of these sessions, www.seniornetmotueka.org.nz  

Organising Your  
Photos 

Wednesday May 
26th 

9:30 - 11:30 $5 one time fee CONTACT: Maureen Hutton,  
0210 2600 432  ahutton440@gmail.com  

Smart TVs and 
Streaming Services, 

Wednesdays, 
May 26th Part 1, + 
June 2nd Part 2  

2:30—4:30 $10 in total for 
members 

CONTACT: Bernhard Nobis,  03 929 8101 
or bernhard.nobis@gmail.com  

Android Devices  
User Group 

Thursday May 
27th  

2:30 – 4:30 $2 for a cuppa CONTACT: Bernhard Nobis, 03 929 8101 
or  bernhard.nobis@gmail.com  

MAC interest Group Friday May 28th  2:30 – 4:30 $2 for a cuppa CONTACT:  Gail Riddell, 0274 777 033 or  
 riddelldna@gmail.com  

15 Ways of Saving  
Money on your  
Funeral 

Thursday June 3rd  2:30 – 4:30 $2 for a cuppa CONTACT: Clive Dyson, 021 022 
33244   clivedyson.nz@gmail.com  

Countries and Cul-
tures Interest Group 

Thursdays, June 
10th Pt 1 and 
June 17th Pt 2 

2:30 – 4:30 $2 for a cuppa All members Welcome —this month our top-
ic is India.  CONTACT: Sandra Price, 0212 645 
233 sandralouiseprice@gmail.com  

Genealogy Interest 
Group 

Friday June 11th  2:30 – 4:30 $2 for a cuppa CONTACT:  Ann Bassford, 03 528 5191 
or  forest.ann@xtra.co.nz   

Members Meeting 
(Note: NOT on June 
7th, being Queens 
Birthday Holiday) 

Monday June 
14th  
 

10:00 – 
12pm 

$2 for a cuppa All members welcome. Speaker is : 
Jean Gorman—on “The Expected Alpine 
Fault and it’s Aftermath”   

Android Devices—
An Introduction 

Wednesdays, June 
16th Pt 1, and 
23rd for Part 2. 

12:00—
2pm 

$10 in total for 
members 

CONTACT:  Mary Dowell, 03 528 8600, or 
marydowell63@gmail.com  

iPad and iPhone  
Interest Group 

Friday  June 18th  2:30 – 4:30 $2 for a cuppa CONTACT:  Colin Hooker,   
bandch@xtra.co.nz   

Help and Support  
(all devices) 

Monday June 21st  9:30 – 
11:30 

$5 for up to 30 
minutes assis-
tance with your 
IT problem. 

All members welcome, non-members fees 
are $10 for up to 30 mins help with their IT 
issue. 

Committee Meeting Tuesday June 
22nd 

10am-12pm   

Android Devices  
User Group 

Thursday June 
24th  

2:30 – 4:30 $2 for a cuppa CONTACT: Bernhard Nobis, 03 929 8101 
or  bernhard.nobis@gmail.com   

Using a VPN service Friday June 25th  10am—
12pm 

$5 one time fee CONTACT: Roger Pittman 
on:   randjpittman@gmail.com  

MAC interest Group Friday June 25th  2:30 – 4:30 $2 for a cuppa CONTACT:  Gail Riddell, 0274 777 033 or  
 riddelldna@gmail.com  

Basics of DNA,  
A 4-part Course 

Tuesdays 
29th June, and July 
6th, 13th & 20th  

9:30—
11:30 

$20 in total for 
all 4 sessions 

CONTACT:  Gail Riddell, 0274 777 033 or  
 riddelldna@gmail.com  
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If you don’t have a printer at home, we have other options right here in 

Motueka.  Our Ever-Resourceful Sandra has done some leg-work and some 

homework on this: 
 
OPTIONS IF YOU DON’T HAVE A PRINTER AT HOME, by Sandra Price 

 
Are you thinking about buying a printer but are 
concerned about what type - inkjet or laser? colour 
or black & white?  And what about high cost  re-
placement ink cartridges? How to connect it to 
your phone or tablet or laptop? Not sure about 
sharing a family member’s printer?  
 

Rather than fork out to buy a printer yourself if you don’t think you are going 
to use it much, here are some inexpensive options you can take advantage of 
right here in Motueka. 
 
1. The Motueka Library has a photocopier with black & white A4 copies 
charged at 20c, or colour A4 @ $2. The lovely library staff will assist if you 
have documents or photos on your phone or tablet – just email to their  
library PC and they will print copies for you. 
 
2. At Bay Pharmacy there is a self service photo lab - use their computers to 
print photos from a USB stick, or direct from your phone or tablet by con-
necting with your charging lead. You can also email your documents or pho-
tos from your phone or tablet and (when their office PC is available) they can 
print for you. Belonging to their “photo club” will give you discounts. N.B. 
other pharmacies may offer similar services, I only checked this one. 
 
3. At Image Creators 175B High St, photocopies are offered in many paper 
sizes, black & white A4 is charged @ 22c, or colour @ $1.50 – minimum job 
fee is $2. Small photos can be blown up and printed on proper photo quality 
paper. Photos or documents can be printed from a USB stick. You can also 
take in your device with the charging lead – but bear in mind that choosing a 
few photos from a large number will take time – so best to put your selec-
tions in a folder as this is not self-service printing. The helpful staff member 
said you can also email items for printing to her and she will print for you. 
You’d need to ask if you have a large volume though.  

Good luck!  Sandra  
 

 

 Don’t have a printer?  It’s No Problem…. 

 

I just discovered my age group!  I 
am a Seenager. (Senior teenager) 

I have everything that I wanted as 
a teenager, only 50-60 years later.    

I don't have to go to school or 
work 

I get an allowance every month.  I 
have my own pad.  I don't have a 
curfew.   

I have a driver's license and my 
own car.  I have ID that gets me 
into bars and the wine store.  I like 
the wine store best. 

The people I hang around with are 
not scared of getting pregnant, 
they aren’t scared of anything, 
they have been blessed to live this 
long, why be scared?    

And I don't have acne.   Life is 
Good! 

Also, you will feel much more in-
telligent after reading this, if you 
are a Seenager.   Brains of older 
people are slow because they 
know so much.    

People do not decline mentally 
with age, it just takes them longer 
to recall facts because they have 
more information in their 
brains.   Scientists believe this also 
makes you hard of hearing as it 
puts pressure on your inner ear.   

Also, older people often go to an-
other room to get something and 
when they get there, they stand 
there wondering what they came 
for.   It is NOT a memory problem; 
it is nature's way of making older 
people do more exercise.  

SO THERE!! 
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Bernhard’s report from the April 22nd ADUG Meeting: 
We started the well attended session with a short animation about 
the basics of a mobile phone. This is part of an online educational 
presentation listed under Online Courses on the website of Senior-
Net Motueka. 
 
In a follow up on the subject of cameras, we thought about topics related to 
the collection of photos taken. This includes editing, backing up, sorting and 
sharing photos. We also looked at the inclusion of camera use in a number of 
apps, such as Google photos, Googles Art&Culture. Translate, Keep Notes. 
 
I presented a Youtube video introducing Google photos. The video showed 
setup options, editing, search, automatic categorising and sharing. Many of 
the members of the group use already Google Photos as a backup. It is 
planned to explore the many features of Google Photos in the next session. 
 
Next we installed Google Keep Notes. Keep Notes is one of the simplest and 
best free note taking apps on mobile. It seems like a simple note taking app 
on the surface. However, it has a ton of fun little features and plenty of extras 
for convenience.  
 
Everyone tried the notes input options, normal text, text with tick box, hand-
written notes, voice input, camera photo capture, use of images. There are a 
lot more fun options which will be covered in another session. 

Bernhard Nobis  
 

Android Devices User (Interest) Group: 
 

iPad and iPhone 
Interest Group: 
To start the May meeting we 
watched an amusing video in 
which Siri was asked to give the 
10th power of a trillion :):)    
Colin spoke about the Podcasts 
app and the wide variety of mu-
sic, talks and radio shows that 
were available.  He demonstrat-
ed how to search for a particu-
lar subject or music genre and 
then played short excerpts from 
his own podcast library. 
 
We then watched and discussed 
a  MacMost video on recent 
Apple innovations - a new iMac, 
a new iPad pro and Air Tags. 
Sandra spoke about a handy 
app, Stocard, that will store all 
one's loyalty cards, library 
cards, AA card, etc on an iPh-
one, and Shirley told us about 
Antenno, an app that can be 
programmed to get messages 
and alerts from organizations; 
she showed us recent messages 
she had received from Nelson 
City Council, one about road 
works and another telling her 
that recyclables would be col-
lected tomorrow. 
 
Next we watched part of a re-
cent Senior Hangout talk about 
the iPhone that covered the 
basics and then described some 
features that were added in a 
recent update.  John Harrison 
then spoke about Ali Express, a 
Chinese on-line shopping app.  
An enormous range of products 
were available at very low pric-
es.  Dolf told us about Pocket, 
an app enabling one to save 
written articles, music and vide-
os for later use.  Finally John 
Croxford told us about MAC 
111, a repair shop for Apple 
products which made 
a very reasonable 
charge for fitting a 
new battery in his 
iPhone. 
 
Colin Hooker 
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5 Fast fixes for some Google 
Docs problems:  
Google Docs one of the free word processing apps which is 
useful if you do not want to purchase Microsoft Office. Very 
easy to use, but you may find these problem fixes below 
useful. Adapted from an article in Computerworld.com 4 
May 2021 

     
Google Docs problem No. 1: “Edit regret” 
There is the universal Undo command — Ctrl-Z (or ⌘-Z, 
on a Mac), which can also be found in Docs' Edit menu 
— but that works only if you just did the edit. If you've 
navigated away from the document since the change 
got made, or if you've made other changes since then 
that you do want to keep, the undo command won’t 
work. 

Here is the fix: Use the Google Docs' robust Version His-
tory system. You can find it in the File menu or by using 
the Ctrl-Alt-Shift-H (or ⌘-Alt-Shift-H) keyboard shortcut. 
There, you'll find versions of your document that were 
autosaved at different points and can be zapped directly 
back over as full replacements for the current version of 
your document. 

The complicating issue, though, is that those versions 
are saved only sporadically, which means you may or 
may not find one from the precise point you'd like to 
restore. The best way around that is to manually force 
Docs when you reach a milestone or  

 

 

 

you're expecting major changes to be made. That way, 
you always know you have a quick 'n' easy way to get 
back to the way things were before.  

To manually force Docs to save a version of your docu-
ment, open the File menu, click "Version history," then 
select "Name current version." Give the version any 
name you want and then that exact state of your docu-
ment will always be available and easily identifiable 
within the main Version History menu. 

Google Docs problem No. 2: “Case craziness” 
Have you ever pasted over text from an email, a web 
page, or some other source and then realized parts of it 
were in ALL CAPS format?  Whatever the case may be, 
save the hassle of manually transforming all that text 
and choose a neat option within Docs. 

Highlight the text in question, click the Format menu at 
the top of the screen, then click "Text" followed by 
"Capitalization." There, deep in the Docs menu struc-
ture, you'll find a one-click tool for changing whatever 
text you selected into all lowercase, all uppercase, or 
title case — with no time wasted and only minimal 
effort required. 

Google Docs problem No. 3: “Auto-format frustration” 
By default, Google Docs performs some formatting mag-
ic that's meant to be helpful but can often be annoying. 
For instance, the service will automatically capitalize the 
first word of every sentence you  

(Cont’d on Page 7)…./ 
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Many SeniorNet Learning Centre's around NZ are struggling with the same 

stark issues as we in Motueka are:   

 Shrinking or nil attendance at workshops classes or courses. 

 Lack of volunteers who can help out either with assisting tutors or shar-

ing knowledge and taking workshops with/for our members.   

 Lack of those available or willing to take on Committee roles. 

 

What are the options for our Motueka Learning Centre if we cannot resolve 

these 3 issues above?      

 

We are blessed to have our own building for our meetings, thanks to the 

efforts of those who came before us.  We aren't short of funds, and in fact no 

Learning Centre in NZ has ever closed due to lack of funding.    While our 

Membership keeps growing well every month, and we know there are folk 

who keenly want to learn and who seek the help and guidance we can offer—

we have fewer than 20% of members who are active.    

 

Many faithful “Auld Hands” who have served our group devotedly (and for 

many years, now), both as tutors and/or committee members are now justifi-

ably stepping down.  More will step down this September, leaving several 

crucial committee roles vacant..   

 

Please consider how you could STEP UP.   Giving even just a few hours a week 

or a month would help - many hands make lighter work for all.    

 

Please contact any committee member to discuss.     Stop SeniorNet Motueka 

from having to contemplate whether it has a future, - or not.   

 

 

Tech Tips: 
 

Shared from our Hutt City 

Learning Centre chairper-

son, Peter Andersen.  Peter 

contributes to a regular 

political blog site 

thebfd.co.nz. as a way of 

promoting SeniorNet. 

 

He has many interesting 

articles to be found there,  

example: 

How to Solve Sudoku, at: 

https://

inyurl.com/4f8fs737 

 

Online Safety, at: 

https://

tinyurl.com/2yabe3n5 

 

A Beginners Guide to the 

Internet, at: 

https://

tinyurl.com/8jax6fhw 

 

. 

 

 

185 High St, Motueka  Telephone  03 528 1111  

Email  motueka@nbs.co.nz   

The Future Might Look Gloomy,    

But We Can All Help…. 

http://thebfd.co.nz/
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Cont’d from Page 5: 

5 Fast fixes for some Google Docs problems, 
Continued:  

type, it'll change all the quotation marks you enter from the standard straight-quote style into curly-quote style, and 
it'll add a hyperlink onto any web address you enter into a document.  It adjusts numerical fractions (like 1/2) into 
single-character symbols (like ½). You can disable every one of those behaviors if you don’t want them. 

The fix is in the two-part preferences menu. Click the Tools menu at the top of the Docs desktop interface, then se-
lect "Preferences" from the list of options that comes up. There, you'll see a list of options for some of Docs' more 
basic text substitution habits. 

This area allows you to turn off the auto-capitalization, allegedly "smart" quote transformation, and automatic link 
formatting, among other things. For the fractions and other more advanced forms of text substitutions, you'll need 
to click on the "Substitutions" header at the top of that same window to find them — and then uncheck the box next 
to any substitutions you want to remove. 

Google Docs problem No. 4: Grammar police overreach 
Docs will highlight text when you've got something wrong with your grammar - useful at times but it can also be irri-
tating. You can disable Docs' grammar suggestions —permanently or on an as-needed basis. Find the fix in the Tools 
menu, under "Spelling and grammar". Click the line labeled "Show grammar suggestions" to uncheck and deactivate 
it. 

You can also turn automatic spelling suggestions off in that same place.  Alternatively, you can use the "Personal 
dictionary" option within that same menu to add specific terms into Docs' vocabulary and keep it from thinking 
they're mistakes. 

Google Docs problem No. 5: Bullet point blues 
Docs makes it easy to add bulleted lists into your documents, and it even has a handful of formatting options within 
its Format menu, under "Bullets & numbering."  Those default options are limited, though.    But wait! 
Docs also allows you to insert almost any symbol imaginable as your bullet list indicator. But unhelpfully, is as the 
option that only appears after you've created a list.  

Try this: Create a bulleted list within a document. Then, with your cursor on that list, open up the Format menu 
and look under "Bullets & numbering" again. This time, you should be able to select the "List options" item — 
and once you do, you can select "More bullets" to select from a large range of bullet symbol styles. 

Motueka SeniorNet Committee 2020-2021 

 

President, and Publicity:   Clive Dyson 

Vice President, Health &Safety:  John Croxford 

Secretary:    Gail Riddell 

Treasurer.  Sponsorship, Annual Stocktake Allan Culling 

Membership Coordinator:   Kay Mathieson-Adams 

Technical, Security, Maintenance:  Dave Samways 

Activities Convenor,  Website updates Sandra Price 

Almoner:     Norah Morris 

Housekeeping, Stationery:   Philippa Hellyer  

Newsletter Editors:   Sandra Price and   

     Kay Mathieson-Adams 

 

 

Non Committee Roles  2020-2021: 

Technical Support, Photocopier:  Colin Hope 

Librarian:    Ann Bassford 

Website Administration:   Bernhard Nobis 

Motueka SeniorNet Contacts: 

 

Email:   motuekaseniornet@gmail.com 

Address:  42 Pah Street, Motueka 7120 

Postal Address:  P O Box 297, Motueka 7143 

 

 

SeniorNet Motueka est 1998. 

 

 

 


